FORENSIC BIOLOGY PROTOCOLS FOR FORENSIC STR TYPING

GENEMAPPER ID ANALYSIS

DATE EFFECTIVE APPROVED BY PAGE
07/11/2016 NUCLEAR DNA TECHNICAL LEADER 10F21

Genemapper ID Analysis

CREATING A NEW PROJECT

L. Double click on the GeneMapper ID v3.2.1 icon on the analysis station desktop.

2. When prompted, enter your username and password.

3. The program will automatically open a new (blank) project. This main window is called
the “Project Window”.

4. Click on File->Add Samples to Project...or Ctrl+K. A ow will open, listing
the drives or folders from which to add the samples on the

5. Navigate to the proper drive, and choose the fold n folders or
samples that need to be analyzed. Select the and click on Add to
List.

6. On the bottom right Click Add. The cho populate the project.

Adding by Sample File (.fsa file):

(7] Add Samples to Project

Edit  Wiew
| Files | &M Database | ammples To Add:
~
El 33-Allelic_Ladder _3_A05 fsa
E[ 34-Positive_control_D022811.1100_h_B0S.fza
E[ 35-Amplification_negative_ID022811 1100_b_C05.fsa
\ E] 36-gxtraction_negative_1_090110.1335_k_D05 fsa s
e
1 1 Add|l Add & Anal
C o ol | Faneal]
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Adding by Run Folder:
(¥ add Samples to Project
Edit  Wiew
Files I GM Databaze I ~Samples To Add:
s My Cormputer - F-_ | HS2_2007-12-06_007&

J 3% Floppy (A

fx Codis an 'ocmednacodis' (F:)
Lk VDR Drive (D)

= FBiology on 'cec.nychnetwucme2CMWE_FileShare' (M)
) Dy Builling

) FEIOLOGY

) FEIOLOGY _1

) FEIOLOGY _2

(L) FEIOLOGY _MaIN

) HighSens_Data

) MG_DATA

) MITC_DATA

3 Morthly Case Update
) Paradox_style

) STR_Data

) Archive STR Data
FHC) CASBWORK
ATHEMA,
18 '-IE:;T-'_:T;'IZIIZIT-’ 2-06_D078
il

¥

Clea_rl FAudd Add&ﬁgalyzel Eancell

A
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B. ANALYSIS SETTINGS
1. All defined settings must be used and can be referenced in Appendix D. Analysis Method

Editor and Appendix G. Default Table and Plot Settings.
From the “Table Setting” drop-down menu in the toolbar, select “Analysis View”.

Project Window:

3;' GeneMapper ID ¥3.2.1 - *Untitled - gmid Is Logged In _10] x|
Filz Edit &nalysis Yiew Tools Help
o @ S| B % || W00 || B B || b @ |[ree s arasbvew Flm||pa|s |
E-EIPraject Sarmples |Gen0t\,-'pes‘ | ‘NBW'“ =
DHSd—QDD?' Statuz | Sample Mame Sample Type  |Analysis Meth " tandard Fun Mam
1 !k E5-Allelic_Ladder |Allelic Ladder  |ID Analysis - _HID_Gss00 HZ4_200 =
Eaze pairs =
2 !k BE-020507 .1100F |Postive Control {10 Analysis Camennrk | | _HID_Gss00 HZ4_200
3 !’”F E7-AB|_Cortrol _C | Sample ID Analygie | DMA_Datasnalysis _HID_Gss00 H4_200
4 I |68-ABI_Control_C|Sammple ID &nalysiz | [Detaut _HD_GS500  |HS4_200
5 W |59-ABI_Cortrol T [Sample D Angifsis eSOt ek _HD_GES00  |Hs4_204

3. If the ladders, positive control, and negativeicontrol have not yet been designated, do so
now under “Sample Type”.
4. When there is mofe than one ladder in a project, designate one of the ladders as “Allelic

Ladder” in thedSample<Type column. Additional allelic ladders within the project should
be designated as “Sample”. If the allelic ladder analyzes correctly the additional ladders
should be deleteddrom thefroject. If the allelic ladder does not analyze correctly,
another allelic ladder indhe project or folder may be designated as “Allelic Ladder” and
thedfailed ladder deleted.

Project Window:
(#) GeneMapper ID v3.2.1 - *Untitled - gmid Is Logged In

File Edit &nalysis Wiew Tools Help

HEmHh BEBEOWN £l b @  Tableseting  |agfisis view v|m &S &
= EJProject Samples |
DRU”—WatS Statuz |Sample File Sample Mame Sample Type | Analysiz Method  |Parnel Size Standard
1 l’ﬁ 01 -AllelicLadder! |01-AllelicLadder |Allelic Ladder | Cao, Pro+ Analysis |Profiler_Plus_v2 |CE_F_HID_G2508 A
2 h 02-pozcontrol 4.|02-poscortrol! 4. |Positive Control |Co, Pro+ Analysis |Profiler_Plus_w2 |CE_F_HID_GS50
3 h O3-ampreg! .4.07 |03-amprneg! .4.07 |Negative Cortre| Co, Pro+ Analysis |Profiler_Plus_v2 |CE_F_HID_GS50
4 !’ﬂ' 04-2CEox1 FJOP- |04-QCEox1 TJOP- |Sample Co, Pro+ Analysiz |Prafiler_Plus_w2 (CE_F_HID_GS500
5 h 05-QCE0x1 TJOP- |05-QCEox1 7JOP- | Sample Co, Pro+ Analysis |Profiler _Plus_v2 |CE_F_HID_GS50
=} LS N MCRAATIND I0R CTRaAA T IND TS el T ODvma Apalosis (Dvafilar Dhos w2 CF F HIDG oSS
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Fill in the correct analysis method, panel, and size standard following the table below.
Once the analysis method, panel, and size standard have been chosen for the first sample,
you can fill down the same information by selecting all three columns. Do this by
selecting the title row of the columns and then while holding down the left mouse button
drag across the three columns, the selected columns will be highlighted blue. Next, click
on Edit = Fill Down or Ctrl+D.

System Analysis Method Panel Size Standard
Identifiler 28 Cycles | ID Analysis 1D28 LIZ-250-340
Identifiler 31 Cycles | ID Analysis ID31 LIZ-250-340
MiniFiler MiniFiler Analysis | MiniFiler_ GS500 y1 | LIZ-250-340
YFiler YFiler YFileray2 LIZ-YFiler

A green arrow in the Status columnof each sample means that the data is ready to be
analyzed. Click on the green arrow;in the‘teelbar. A “save project” prompt will pop-
up asking for the run to be named.

Run

(#) GeneMapper ID v3.2.1 - *Untitled - gmid Is Logged In

File Edit A&nalysis Yiew Tools Heélp

SLEICEY AV ITENL

vE B& =»

Table Sefting. | Analysiz Yiew

Namne the project with the same name of the run followed by the analysis parameter and
the ‘analysis set'(iier, “Newton062514 32-33IR A or Serena06141451-53M B”). Click
OK to'start analysis.

The progress of the analysis can be seen at the bottom of the project window in the
progress status bar. Once analysis is finished the blue progress bar will stop, and the
bottom left corner of the screen will read “Analysis Completed.”
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C. VIEWING ANALYZED DATA

Samples View — Overall Sample Quality Flags

1. In the Project Window under the Samples tab, the columns to the right side with colored
shapes are Process Quality Value (PQV) flags. These flags do not replace our method for
editing samples. Each sample must still be viewed and edited. The flags are simply a
tool to draw your attention to samples that have analysis problems therefore assisting you
with initial analysis, and editing.

2. The Pass (green square) symbol indicates that no problemexists. Ifa yellow “check”
flag, or a red “low quality” flag result in any of the columns, referto the appendix A —
“Quality Flags” for a description of the flags and the problems they identify. Whether a
problem is flagged or not, proceed to the sizing section of the,manual to individually
check each size standard.

Samples tab Quality Flags
Project Window: A
[ )JGeneMapper ID v3.2.1 - Nob-_4050907_96-97 - gmid Is Logged In - |0 x
File Edit &nalysis Wiew J#bls Help
i 8| il || TR > & [P e v aEIFEIEE
= =Proje Samples | Genotypesl PR

|j" |Statu3 |Sample Mang arnple Type alysis Method |Panel ze Standard Run Marnme |SQO |SFNF |SNF |OS |SQ

I 1 00 Mobel_2007-0 EEE e

2 34-AQ50207 1600 |Pastiye Control |ID Analysis CE_G5_HID_G2500  |Maobel_2007-0 . . .

3 35-A050207,.1 GO0 Postive Contfah|ID Analysis D25 |CE_GS_HID_G3500 |Mobel_2007-0 . . .

4 36-A5|_Contral £ Sample D &nalysis D28 |CE_G5_HID_GS500 | Mobel_2007-0 E B B m

5 37-ABI Control_F|Sample D 2nalysis D28 |CE_G5_HID_GS500 |Mobel_2007-0 E B B m

& 36-AB|_Contral_L|Sample D Analysis D28 |CE_GS5_HID_GS500 |Mobel_2007-0 E mmm

7 39-AB_Contral_L|Sample T Analysis D28 |CE_GS_HID_G5500 |Mobel _2007-0 . . . .

g 40-AB|_Contraol _L | Sample T Analysis D28 |CE_GS5_HID_G5500 |Mobel_2007-0 . . . .

9 41 =B _Contral_C | Sample I Analysis D28 |CE_GS_HID_GS500 |Mabel_2007-0 . . . .

10 49-Allglic_Ladder | Allelic Ladder |10 Analysis D28 |CE_GS_HID_GS500 |Mabel_2007-0 . . . .

1 50-2050207 1600 | Postive Cortral |I0 Analysis D28 |CE_GS_HID_GS500 |Mabel_2007-0 . . . .

12 51-4050207 1600 Postive Cortrol |ID Analysis D28 |CE_GS_HID_GS500 |Maobel_2007-0 . . . .

13 61-Buc27f_250py |Sample D Analysis D28 |CE_GS_HID_GS500 |Mobel_2007-0

o E mm e

Analysis Completed. - step |
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D. SIZING

1. Select all of the samples in the Samples tab by clicking on Edit-> Select All.

2. Next, click on the Sizing icon and the Size Match Editor window will open.

Sizing icon

(7) GeneMapper ID v3.2.1 - Untitled - gmid Is _ugged In

File Edit  Analysis Wiew Tools Help

@( = @l % Dﬂl lelﬂ L M > 6 Table"ng: Aakysis View w m @ = ooy

Size Matches. tab Sizing Quality value
Size Match Editor window:

(@)5ize Match Editor x|
File Edit ‘“iesw Tools
X 8 || / / e \ e
01-_# | Size Metches | M Caling Curve | /
0z2-_E v
03-_C 1 ’ Sizing Quality= <1.0> Dveride S0
04-_C
05 E 1400
ne-F 1200 Mo 0 200 =00 350 400 as0 480500
1000 100
75 {
200
I |
&00
400
200 H
R TR T T T - 5000 T s ' T wm -
o | I !
oK | Cancel | Apply |
3. Using the arrow keys, scroll through the samples on the left column and check the sizing

for each sample in the Size Matches tab. The sizing is displayed as a plot with the base
pairs displayed above each peak. See Appendix F for a reference of size standards.
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a. Identifiler samples are run with LIZ 500 and should not have the 250 bp or 340

bp size standard labeled. At least the 100bp to 450bp peaks must be present for
proper sizing.

b. MiniFiler samples are run with LIZ 500 and should not have the 250 bp or 340
bp size standard labeled. At least the 75bp to 400bp peaks must be present for
proper sizing.

c. Y filer™ samples are run with LIZ 500 (LIZ-YFilef) and should not have the 250
bp size standard labeled. At least the 75 — 4004p peaks must be present for
proper sizing.

4. Red octagon symbol in the SQ column of thé projectwindow:

In some cases you may still be able to useithis data by redéfining the size standard for
that sample. For instructions on how to re-label peaks‘which have been incorrectly
labeled, see the Appendix E — Troubleshootingsection of this manual.

5. While still in the Size Mateh Editor'window,document that each sample size standard has
been inspected by selecting Edit 2 “Override All SQ” or Ctrl+Shift+O; Click Apply
and then OK. The Size Mateh Editor window will then automatically close. A blue “X”
will appear in the 8izing quality'check box (SQO) for each sample, signaling that the size
standard for each sample has beenreviewed.

Project Window:

'_‘_-'i;:EeneMapper 1D ¥3.2.1 - *Esther041706_267L_251_0.1 - gmid Is Logged In - Dlﬂ

Fle Edit Analysis View Tool p

&f = @]H% =] |MM| | [ 1 ||TableSeﬂing.|||Analvsis\f’iew le“,@ §|Ni

E-=IProject Samples | Genotypes: I N

[_[Copr Stetus |Sample Mame Satmple Type | Analysis Method Panel Size Standard Run Matre SG0 | SFNI SMF |05 SG uct oz U3

1 01-Allelic Ladder |Sample D Analysis D23 LIZ-250-340 Copy of Run_ x . . . .
2 02-2041307 .101¢ |Positive Cortrol | 1D Analysis o2& LIZ-250-340 Copy of Run_ x . . . .
3 03-2041307 1018 |Megstive Cortre | ID Analysis o2s LIZ-250-340 Copy of Run_ x . . . .
4 04-Comgp 28-38, | Sample I Analysis o2s LIZ-250-340 Copy of Run_ x . . . .
5 05-Comp 28-38 | Sample ICr Analysis D2 LIZ-250-340 Copy of Run_ X . . . .
[ ot 28-3 i LIZ-250-340 _ B E E M|

KT |

Analysis Completed L stp |

6. If a green triangle appears in the status column for any of the samples after you applied

the SQO, press the green analyze button in the toolbar to finish the sizing quality

override.
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E. PLOT VIEWS

Samples Plot — Reviewing Ladders, Controls, and Samples

I. First, check the ladders and controls in the project using the following steps. If a project
contains more than one allelic ladder, each ladder must be reviewed and pass analysis.
Then repeat the steps for the samples. See Appendix F for a reference of allelic ladders
and positive controls.

2. If there are two positive controls of the same date and #ime (i.e. high\ and normal), you
can remove one by selecting it in the Samples tab of the Project Window, then from the
pull down menu select Edit = Delete from Projeét > OK.

3. In the Samples tab of the Project Window, select the samplerows you want to view (i.e.
ladders, controls, or samples) then cliek the plot button w to display the plots (Analysis
- Display Plots or Ctrl+L). Use the shift key or the etrl key to select multiple samples.

Plot button Samples tab

Project Window:
=) GeneMapper ID ¥3.2.1 - *Untitle . - gmid, Is Logged'’.,

File Edit Analysis Yiew Tools

@F iﬁ @] % Dﬂ I A‘ '7_ g ‘ 6 Table Setting: |Anal\;sis Wiy v|ﬂ @ % R

= EJProject
CRun__vvat=

|Sample Mame  |Sample Type | Analysis Method |Panel

Prof

04-2CEox1 TJOP- |04-QCEox1 TJDP- | Sample Co, Pro+ Analysis Profiler_Plus_v2

4. In the “Samples Plof” window toolbar there is a Plot Setting dropdown list. For
Identifiler and YFiler, select “Analysis View.” For Minifiler, select “Mini Analysis.’
This will label the peaks with base pairs, RFUs and allele name.

’
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“Plot Setting” dropdown list

Samples Plot windopt:

= [Samples Plot
File Edit  view Tools aleleffHeln

iot Setings [0 mreryes =10 || penes = | T I | | a1 r
[ | | ol ieu e | | B0 oo |t ] | 808 (#%-Axis Zooming x|
Sample Name sgo [os  [sQ wryen

|24 a0s0207 1600PELC =< ]

100 120 140 180 180

£000
4000

2000
SN

EEE]
137.70(139.45
1111111

AJ
7 oL 0 oL o oL
119.24| [132.47| |142.20 185,09 [202.19 228 .72
1038 | [103 17 78 [Bo35 G097
[
10363
110

Right click
in this area
for x-axis
zooming

5. Adjust the window zéom by right clicking above the plot pane and using the X Axis
Zooming dialog box to zoom inte a specific range. Alternatively, hover the mouse above
the panel; it will change into a magnifying glass that can be used to draw a box around a
selected areato zoomi'in.

6. If yousstill have “nowoom for labels™, for example when you have many alleles per locus
such as the Allelic Ladder, it may be easier to review the sample in the “Genotypes Plot”
as deseribed in Appendix E — Troubleshooting Guide, 3. Genotypes Plot — Locus Specific
Quality'Flags. The Genotypes Plot is an alternate view option showing each locus in a
separate pane. The locus specific quality flags can only be viewed in the Genotypes Plot
window.

NOTE: Refer to the Appendix A — “Quality Flags” for a description of the flags and the
problems they identify.
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F. EDITING

Electronic Editing — First Analysis

1. You can view the sample in the Samples Plot window or the Genotypes Plot window or
minimize back and forth between these views to facilitate analysis. Just ensure that you
are using the correct view settings (“Analysis View” or “Mini Analysis.”)

2. Left click on the allele in question to select it.

3. To edit the allele you must right click on it while itis highlighted and you will see a list
of three choices — Delete Allele(s); Rename All€le; History.

R _— -
66._BO)_03 f5a ‘w Pusitive Conirel 07702002 113 ‘ ]

[ ] DESIITS |D2ISIL

100 200 200 a00 500

3000

2000

1000

. i .

i £ i 19
103.17) [208.68 l294.95| 31221
3041 a7 1519 | [1672

Left click
__toselect

G6-_B03_03 fsa

= B 201 DEEEL ]

100 200 300 a0 500

3000

2000,

) M
o . . I} . s
= o

31231
1670

Rename Allzle b

Right cIick/y o

to edit

‘
Dalte Alliats ‘

4. Select Rename Allele; another drop down menu will appear listing all of the possible
choices for alleles at that locus including “?”” and Custom.
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5. If the sample has been labeled an Off Ladder (OL), choose “?”. If the peak has been

given an allele call, chose that same allele call from the drop-down list.

For example, if a pull-up peak has been labeled a 7, highlight the 7 then right click and
rename the allele 7 from the drop-down menu. This is done so that the reviewer can see
what the allele was originally called.

6. A dialog box will then prompt you for an Edit Allele Commentipln the box enter the code
for the allele edit (see Appendix B for a list of editing codes).

7. Click OK.

16-_B03_STARS 03 fsa. 19~ Pesitive Condrel 1248106 4:00 1| ‘ ’

o
[EMEL] [DESLITS ] [DZTSIT B W s [DIE58T
1 120

400 410 430 140 150 160 170 0 490 200 210 220 230 240 250 20 210 280 230 300 310 420 330

000

2000

2000

cal SS
b
— :
8. You will notice on the electropherogram that the peak has been labeled as follows:

“changed”, the allele call, base pair, and RFU, followed by the corresponding edit code.
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9. If you are removing all the labels from peaks in the entire sample because it needs to be

rerun, for example, when a sample is completely overblown, then you can delete all the

labels from peaks together without renaming each peak. The rerun is documented in
column UD1.

a.

To delete a range of labels from peaks, select the first peak of the range, and
while the first peak is still highlighted, drag a box across the range of peaks to
select everything. Right click on the selection and click Delete Allele(s). When
doing so, a box may pop-up with a message that more.than one allele will be
deleted. Click OK then enter the edit type in thedllele comment box.

If the removed labels from peaks need to be put back in, highlight the necessary
samples from the Samples tab in the project,window. From the Analysis drop
down menu, select “Analyze Selected Samples.” A pop up window will ask for
confirmation and state the action cannot be undone. Click OK. Edit the
sample(s) appropriately. If this action is done as a change to the original project,
there is no need to change the projeet name. Create new tables and re-export the
project.

10. If you mistakenly delete a labeldfrom ‘apéak peak instead of renaming it first try to undo
by selecting edit from the drop down menuthen select undo. You can undo as many
changes as you made while that plot' window was open, but if you close and re-open the

plot window you willinot be able to undo.

11. To revert a deléted peak back to the original allele call, select the peak, right click, then
choose add allele call when prompted for an add allele comment leave it blank.

a.

b.

The, original allele call will be added to the peak but the word “changed” will still
appear in thelabel.

The word “changed” will not appear in the printed electropherogram, but it will
appear in the electronic editing sheet as a sample entry with no edit comment.
When the editing sheet is generated, scan through the sheet for any sample
entries without edit comments these are the peak labels that were added back in.
Manually remove them from the worksheet before you print.
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12. Once editing has been completed you can view the edits in the Genotypes table. This
table contains all of the alleles, sizes, and edits for all of the samples. Up to 15 edits can
be captured per locus.

Genotypes Table

w  Tools Alleles  Help
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Electronic Rerun Sheet
1. If a sampleieeds to be rerun, this too is electronically noted. Close the Sample Plots
window and return to the Samples tab in the Project Window.
.
enter rerun code in UD1
Project Window:
“E;:Genenappgr ID ¥3.2.1 - *H53030607_63M - gmid Is Logged In =12 x|
File Edit Analysis view Tools Help
o O || B 7|l ][ T A B[ b @ [ seing |[easmvon -IE||fs = \
[=-Project sanples | Genotypes |
|Stetus |Sample File |Sample Name — [Sample Type  |Specimen Cater| Analysis Methad |Panet |Size Stancard Run Mame S0 [SHF[uDd [up2 [UD3
1 ot [} S v2 [ 3
2 34-020207 1800P | 34-020207 1800P | Positive Control \no export 1D &nalysis Idertifier w2 CE_C _G5500 Run_HS3_200 x . # PEIC -
3 35-020207 1800P | 35-020207 1800F | Positive Control \no export 1D Analysis Idertifiler_v2 CE_GS_HID_GS500 Run_HS3_200 X . 1] PEHIC -
4 36-ABI_Control_C | 36-AB|_Control_C| Sarple no export 1D Arealysis Iedertifiler_v2 CE_G5_HID_GS500 Run_HS3_200 x . PEG2|QC
= 37-LE|_Control_C|37-ABI_Cortrol_C|Sample no export ID Analysis Idertifiler_v2 CE_G5_HID_GS500 Run_HS3 200 % [ [ PE 62|aC
& 38-ABI_Cantrol L |36-AE|_Control_C|Sample no export D Aralysis Idertifier_v2 CE_35HD_GSS00  |Run HS3 20t [ |0 [PE07|ec
7 39-LE_Control_C|39-2BI_Cortrol_C|Sample no export ID Analysis Idertifiler_v2 CE_G5_HID_GS500 Run_HS3_200 % [ [0 PE07|QC
5 40-4B1_Cartrol_C|40-ABI_Cortrol_C | Sarple: o expornt ID Arlysis Iertifiler_v2 CE_GS_HID_GS500 Run_HS3 200 3 (@ [ PE07 QC
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2. Each sample scheduled for rerun must contain a code in column UD1. The first figure of

the code stands for the sample status, the second figure stands for the multiplex system
of the sample, and the third figure stands for the rerun parameter. The following are a
few examples:

a. A sample was overblown and all labels from peaks were removed. It should be
rerun at a 1/10 dilution in Identifiler. Rerun Code: **ID

b. An ID28 sample contained an off-ladder allele and needs to be rerun normal in
Identifiler. Rerun Code: "I.

c. An ID31 sample has a poor size standard and needs to be terun at the normal
parameter. Rerun Code: #IN

d. A sample has already been rerun once and the second time still produces an off
ladder allele, therefore it will not be rerufi. Rerun code: "N/A

e. A ID31 sample needs to be rerun at two separate parameéters: one rerun at normal

parameter for a range of labels on peaks, removed .and another to confirm an
off-ladder using rerun high. Listsboth parameters separated by a comma. Rerun

code: *IN, "TH
3. After entering a code, click outside of'the cell for the data to export properly.
4. See the Appendixes B and C for a complete list of edit, system, and rerun codes.
Exporting Data for LIMS

Any case documentation developed eutside of the LIMS should be scanned to a PDF document
and attached to_thesappropriate eleCtronic case record

1. Toexport thisginformation for use in the LIMS:

a. Fitst, in the Project Window, make sure the table setting drop down menu is set
to “Casework”. In this view you will notice an additional category column
“Specimen Category” this column should be set to “no export” for all the

samples.
b. Then, Go to File > Export Combined Table. This table combines the rerun
information from the Samples table and the editing information from the
Genotypes table.
2. Select the appropriate run folder and check the run name contains the initials of the

person analyzing the run.

3. The file must be exported as Text-tab delimited (.txt). Ensure this is selected and click
“Export Combined Table.”
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Casework table setting

Project Window: /
Fle Ede  Anslyss Wew Took Help
ol N N T N | e I | = A== A

Sarvios |
-

ER=T
& [(Amnreis

To make the data available for review, the project needs to be exported from the
Oracle database and placed on the:network. Once on the network, the reviewer will
have to re-import thejproject into a'llocal Genemapper station before being able to

review.
Exporting a Project
1. Click omwToels = GeneMapper Manager (Ctrl+M) or click on the GeneMapper Manager
icond

Select the project to export and click the “Export” button. A new window will open. Navigate to the
3130x/ run folder through the “Save in” drop down box. In the “File name” box type in the name of the
run. The “Files of type” box should be defaulted to Java serialized file (*.ser).
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GeneMapper Manager icon

Save in your 3130x! run folder

/ -

Project Window:

eneMapper 1D v3.2.
File Edit Analysis Wiew Tools Help

Ei‘ﬁ”% GIfIHJ!IJII.MIJ_UHEQ ||>6||TabIeSeﬂing:|||Analy3is\-"iew LIE”‘@%H'E' |
Samplesleencﬁypesl /

|Status | Sample Name |Sample Type |Analysis Method [Panel [Size Standard [RunMame  [S@0 [SFNF [gF (05 [S@  |[uD1 [uoz [UDs

— Run oc /

2 /GeneMapper Manager x| ‘—| '_l |_|

= Run_HS2_200 ] ]

Projects | analysis Methods | Table Settings | Piot Settings | Matrices | Size Standards | R A 0t B mm

Project Last Saved Cryrer # of Sarmple
T PP oy b S A £ —l [FiE220 @/ (m W (m
AL16_ID3E1 -3k 22zec 2005-09-22 1:35:33:0|gmid
Athenall 28058 _6M 2005-02-26 11:34:2 | grnid vI I ,.3 |
Athenal32508_59H 2005-04-08 13144 |gmid V' AV 4

2009-01-08 11:43:0|gmid

Athenal32905_38IR

2009-01-06 11:4

Athenal33106_66H 2005-04-081210:5 -
Athenal 205307 _60-61H 2008-10-14 12:05:1 |gmid -
Athenal 20307 _G60-61H JT | 2005-11-12 16:26:2 |amid |
Athenal 20407 _G67M 2008-10-14 12:50:2 | gmid —
Athenal 20407 _67H JT 2008-11-1310:30:4 | gmid —
Athenal 20407 _G5L 2008-10-15 11: 065 gmid —
1 %
A N
Rename...
File name: IAthe?DSQQDS_SBIR_JT Save |
Files of type: % serialized file (*.zer) - I Cancel |
ALl 5] /
inalysis Completedl ‘ / | ity

Export
Type in the name of your run

G. EDITING - REVIEWER

Importing a Project

1. To import the project, open the GeneMapper Manager and click Import.

2. A new window will open asking for the file name. Navigate to the appropriate run
folder, select the project and click Import. The project will be imported into
GeneMapper.

Controlled versions of Department of Forensic Biology Manuals only exist in the Forensic Biology Qualtrax
software. All printed versions are non-controlled copies.

© NYC OFFICE OF CHIEF MEDICAL EXAMINER




FORENSIC BIOLOGY PROTOCOLS FOR FORENSIC STR TYPING

GENEMAPPER ID ANALYSIS

DATE EFFECTIVE APPROVED BY PAGE
07/11/2016 NUCLEAR DNA TECHNICAL LEADER 17 OF 21
3. To open the project you just imported, click File = Open Project (Ctrl + O). Select

your project and click Open.

Electronic Editing - Reviewer

1. The reviewer should check the edits on the editing documentation against the electronic
data.

2. To display the sample plots, highlight all samples and click the “Plot, View” button or
click “Analysis a Display Plots”. For more detailed information, refer to Section E “Plot
Views”.

3. The software always keeps the original allele assignments and a list of all the changes

made. If desired, the allele history cande viewed." See ~Appendix E — Troubleshooting
Guide, 6. Allele History” for instructions.

4, To change, revert, or add an edit into the documentation, the reviewer should make the
correction in the edit tables

5. In the GMID projeet, to reverban edited peak back to the original allele call, left click on
the allele to sele€t it, then right click to Rename Allele; another drop down menu will
appear listing all of the possible choices for alleles at that locus. Select the correct allele
assignment to re=label the peak. This change will still be added to the history of that
alleles

NOTE: « Peaks can be selected and labels deleted together. For example when a sample
is overblown, and you need to remove labels from many peaks in a range,
simply select the first peak of the range, and while the first peak is still
highlighted, drag a box across the range of peaks to select all. Press the delete
key.

If the reviewing analyst disagrees with the removal of labels from all peaks made during
the first analysis, the reviewer should not complete the review. Have the analyzing
analyst go back to the project and reanalyze the affected sample(s), re-export the data and
create new allele, edit and rerun tables and re-submit for review. The reviewer should
then review the entire project again.
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6. Once the reviewer approves all the edits, the peaks that are slated to be removed should

be deleted by selecting the peaks individually and using the Delete key.

7. A “Delete Allele Comment” box will pop-up. This can be left blank if you agree with
the edit. If you made a change to the edit on the editing table, enter the new edit code.
Click OK.

8. Once the changed allele labels are deleted, the electronic editifigisheet cannot be

recreated. Therefore, Re-Save the project as the run name with “Reviewed” so the
original edited project is not lost.

9. Generate the electropherograms using the instfuctionsdn the next section, Section H
Printing and Electropherogram Generation .

9. Export the new project to the run folder on the network as described in the previous
section.

10. Once the project is exported, delete it from the project window in the GeneMapper
Manager.

11. Changes to any reviewed projectican be saved under the same “reviewed” name.
However, the affected pages must'be hand initialed by the analyst making the changes.

H. PRINTING AND ELECTROPHEROGRAM GENERATION

The followifig are the page settings for the printer that can be checked by selecting File from the
drop down menuthen Page Setup while in the Samples Plot view.

Table Tab Plot Tab
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Page Setup ﬁl Page Setup ﬁl

| Pit |

= Page Order
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" Large
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Printing: ID28, YFiler, and MiniFiler

L. Printing is done separately for the allelic ladders, controls, and samples. All allelic
ladders in a project must be printed.

2. In the Project Window under the Samples tab, select only the rows you want to print.
3. Click the plots button.
4. In the Samples Plot window, select the plot setting from the drop down list according to

the system and sample type you need:
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Print - ID Allelic Ladder Print - ID Controls Print - ID 28 Samples
Print - YFiler Allelic Ladder Print - YFiler Controls Print - ID 31 PE and
Samples

Print - Mini Allelic Ladder Print - Mini Controls Print — YFiler Samples
Print — ID31 Negative Print - Mini Samples
Controls

Notice that the font size is reduced to accommodate the print setting. This setting will
add the appropriate labels to each peak for printing.

Zoom to the appropriate range by using the X-AXis Zooming dialog box to set the plot to
the correct range listed in the table below:

X-Axis Zooming:

Identifiler Zoom from 90 to 370
YFiler Zoom from 90 to 340
MiniFiler Zoom from 68 to 300

Select File from the dfop down menu, and then print (ctrl+P). Print to PDF format for
LIMS. Save the PDF into the'same directory as the analysis project. For the ladder, save
the file as “Ladders”. For the controls, save the file as “Controls”. For the samples, save
the file as the'*[sample number]” on the plate. For example, if the sample was run as
sample #23 ontheplate, thetr the PDF will be saved as “23.pdf”.

If the peaks appear unusually small against the baseline in the printed electropherogram,
follow thed@dditional instructions in Appendix E - Troubleshooting, 4. Printing, and re-
print the affected pages.

Printing: ID31Positive Control (PE) and Samples

For ID31 Allelic Ladders and Negative Controls, use the associated ID print views.
Continue below for printing the Positive Control and Samples.

In the Project Window under the Samples tab, select the replicates of one sample and its

corresponding pooled sample (i.e. “trigger swab a”, “trigger swab b”,
“trigger swab_c”, and “trigger swab_abc”).

Click the plots button.
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4. In the Samples Plot window, select the plot setting from the drop down list titled “Print —

10.

ID31 PE and Samples”.

Notice that in the Samples Plot tool bar only the blue dye is selected. This is because one
color will be printed at a time for these sample replicates.

Using the X-Axis Zooming dialog box, set the plot to zoom from 90 to 370.

Select File from the drop down menu, and then print (ctrl#P). Print to PDF format for
LIMS. Save the PDF into the same directory as the analysis project.

If the peaks appear unusually small against the baseline in the,printed electropherogram,
follow the additional instructions in Appendix'E. Troubleshooting Guide, 4. Printing,
and re-print the affected pages.

In the Samples Plot tool bar, unseleét the blue dye by ¢elicking it, and select the green dye.
With only the green dye selected repeat stéps 6 and”7 for the green dye. Then repeat
steps 6 and 7 for the yellow dye and red'dyes individually.

After all colors have béenprinted for one triplicate sample, repeat steps 1 through 7 for
the next sample ingthe injectiomuntil all samples in that run have been printed.

Controlled versions of Department of Forensic Biology Manuals only exist in the Forensic Biology Qualtrax

software. All printed versions are non-controlled copies.

© NYC OFFICE OF CHIEF MEDICAL EXAMINER




